
 

 

       
Date:      November 1, 2020 

 
      DAL:      DHCBS 20-12    
      Subject:    2019 LHCSA Statistical Report and  
            2019 ALP LHCSA Statistical Report  
 

Dear Administrator: 
 

The 2019 Licensed Home Care Services Agency (LHCSA) Statistical Report and the 
2019 Assisted Living Program (ALP) LHCSA Statistical Report will be made available for 
downloading on November 1, 2020. Reports must be submitted by December 31, 2020. 
 
LHCSA Registration Process 
 

Section 3605-b, of the Public Health Law (PHL) has been amended to require annual 
registration of all licensed home care services agencies with the Department of Health. As such, 
all LHCSAs, including those affiliated with an ALP, are required to be registered with the 
Department beginning January 1, 2019 and annually thereafter. The registration status of each 
LHCSA will be publicly posted on the New York State Department of Health website at 
https://health.data.ny.gov/Health/Licensed-Home-Care-Services-Agency-Registration-St/t96r-
z8r7 

 
LHCSAs that were licensed during the current year, 2020, will be automatically 

registered for and may provide services and bill during 2020. In addition, they may register for 
2021 using the LHCSA Registration Short Form, a HERDS survey on the Health Commerce 
System. All other LHCSAs must register for 2021 by successfully submitting a complete 2019 
LHCSA Statistical Report and/or 2019 ALP LHCSA Statistical Report. Failure to complete and 
submit the statistical report by the stipulated deadline will result in the following penalties: 
 

• A $500 fine will be assessed for each month, or part of a month, that the organization is 
not registered. 

• Agencies that are not registered will not be allowed to operate until they become 
registered. 

• Agencies that fail to register timely for two years, not necessarily consecutive, may have 
their licenses revoked.  

 
ALP LHCSAs 
 

All ALP LHCSAs must submit the 2019 ALP LHCSA Statistical Report. An ALP LHCSA 
serving patients in the community must also fill out and submit all sections of the 2019 LHCSA 
Statistical Report to report data for these community patients. However, an ALP LHCSA that 
does not serve patients in the community must only complete and submit the 2019 ALP LHCSA 
Statistical Report. For those ALP LHCSAs submitting both reports, the submission date of the 

https://health.data.ny.gov/Health/Licensed-Home-Care-Services-Agency-Registration-St/t96r-z8r7
https://health.data.ny.gov/Health/Licensed-Home-Care-Services-Agency-Registration-St/t96r-z8r7
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f irst successfully submitted report will be considered the submission date for the agency for 
registration purposes. 
 
Report Platform 
 

The 2019 LHCSA Statistical Report and the 2019 ALP LHCSA Statistical Report will use 
the NYSDOH developed Universal Data Collection System (UDCS) platform.  
 

• Please review and follow the directions that will be provided when the 2019 Statistical 
Reports become available on November 1, 2020. 

• Only those assigned the Health Commerce System (HCS) Administrator Role will be 
allowed to submit the report. It is imperative that your agency’s HCS Administrator Role 
assignments be accurate and up to date. The LHCSA Administrators from the 2018 
Statistical Report are currently loaded on the Healthcare Financial Data Gateway.  New 
Administrators will be added manually. If you are unable to access the report on the 
Healthcare Financial Data Gateway, please send an email to 
HCStatRpts@health.ny.gov to ensure that permissions to access the UDCS platform are 
in place.  

• The UDCS application and the LHCSA Statistical Report forms must be downloaded 
from the HCS and installed on a user’s computer. There have been changes to the 
software therefore users will need to download the revised software. Users designated 
by the agency can then enter the required data.  

 
Revisions to the Report 
 

The 2019 LHCSA Statistical Report will be very similar to the 2018 LHCSA Statistical 
Report. A question has been added to the LSR1 Agency form so that LHCSAs providing 
companion care services can report this line of business. 
 

The 2019 ALP LHCSA Statistical Report will be the same as last year’s report. 
 

Please continually monitor the Health Commerce System. Information will be provided 
through the HCS including directions for downloading and installing the UDCS application and 
the LHCSA Statistical Report forms, suggestions for using the application in different technical 
environments and organizational structures, entering data into the forms, and submitting the 
completed report. Please read these documents carefully. The 2019 LHCSA Statistical 
Report is extensive and the successful registration of your LHCSA depends upon your 
submission of an acceptable LHCSA Statistical Report.   
 

Thank you in advance for submitting your 2019 LHCSA Statistical report on time. Please 
send any questions, comments, and concerns to HCStatRpts@health.ny.gov.  
 
              Sincerely,  

       
                     
              Carol A. Rodat 

Director                                                                      
Division of Home and Community Based Services 

 
Attachment  

mailto:HCStatRpts@health.ny.gov
mailto:HCStatRpts@health.ny.gov
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Attachment to DAL 20-12 

 
2019 LHCSA Statistical Report 

 
Changes from last year 
 
A question enabling agencies to report if they are providing companion care has been added. 
 
List of all Validation Edits 
 
LSR1/LSR10 – The answer to the question “Did this Agency Serve patients during the report 
year?” on LSR1, must match the answer to the question “Did this LHCSA provide patient care 
services during the report year?” on LSR 10.  
 
LSR2 – The Total of Discharges in the Length of Stay section must match the total of 
discharges in the “Discharge to” column in the Referrals and Discharge Section  
 
LSR 2 – The unduplicated patient count on LSR2 must match the total of unduplicated patients 
reported on LSR7.  This total is displayed on LSR2 
 
LSR2 – The number of total cases listed on LSR2 must match the total number of cases 
referred on the “Referred From” column in the Referrals and Discharge Section  
 
LSR3 & LSR4 – If hours or visits are entered on LSR3/4 Revenue Form, then there must be an 
amount in the “Gross Revenue” column.  Conversely, if an amount is entered in the “Gross 
Revenue” column, then there must be an amount entered in hours or visits. 
 
LSR6 – An edit has been added to limit the number of staff and W2s to a certain amount or 
lower – to avoid errors of large entries.  The upper limits are 17,000 for the number of HHAs, 
17,000 for number of PCAs, and 25,000 for the number of W2s. 
 
LSR 7 – If there is an amount listed under “Cases” then there must be an amount listed under 
“Hours” or “Visits” to correspond.  Conversely, if there is an amount listed under “Hours” or 
“Visits”, then there must be an amount listed under “Cases”. 
 
LSR7 – If there are amounts listed under “Cases” (it is totaled at the bottom of the form) – there 
must be an amount in the “Unduplicated Patient Count” f ield.  Conversely, if there is an amount 
in the “Unduplicated Patient Count” f ield, then there must be an amount entered under “Cases”. 
 
New – LSR7 – The amount entered in “New Admissions” field must be less than or equal to the 
amount entered in the “Unduplicated Patient Count” f ield. 
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List of all Required Fields 
 
LSR1 – Rows 1-10 Contact Information 
LSR10 – Rows 12-14 Registration Attestation 
 
 

 



Licensed Home Care Services Agency Statistical Report Overview 

Licensed Home Care Services Agencies (LHCSAs) offer home care services to clients who pay 
privately or have private insurance coverage. These agencies may also contract to provide 
services to Medicare/Medicaid beneficiaries whose cases are managed by another provider or 
entity, such as providing home health aide services to a certif ied home health agency patient or 
providing a licensed practical nurse for a Medicaid prior-approved private duty nursing shift. The 
NYS Department of Health is responsible for oversight of these agencies. There are currently 
about 1487 Licensed Home Care Services Agencies; we estimate that over 100 of these are not 
operational.  

Licensed Home Care Services Agencies are required to submit an annual statistical report. 
Historical submission rates (pre-2018) were around 65%. In 2017 the Public Health Law 3605-b 
law (attached) was amended to require that Licensed Home Care Services Agencies be 
registered annually; unregistered Licensed Home Care Services Agencies are forbidden to 
provide services or bill for services,  are  required to pay fees for late registration and risk 
revocation of their licenses for multiple instances of late or non-registration. Licensed Home 
Care Services Agency registration is accomplished by the Licensed Home Care Services 
Agency submitting a complete statistical report and indicating their desire to register on the 
report.  

The Licensed Home Care Services Agency Statistical Report submission rate has increased to 
almost 90% since this change was instituted. This represents an increase in the amount of data 
that is available for analysis of this sector of the health care industry and it has fostered 
communication with providers that were previously ‘’dark’. In addition, it has provided a tool for 
closing non-operational Licensed Home Care Services Agencies.  

The data collected on the Licensed Home Care Services Agency Statistical Report includes 
general patient statistics, costs and revenue by service (nursing, Home Health Aide, etc.), 
staffing, the numbers of patients served and the services rendered by county, workforce, and 
registration information. Licensed Home Care Services Agencies associated with Assisted 
Living Programs (ALPs) in an Adult Care Facility (ACF) submit a different set of data due since 
they are reimbursed at a daily rate, not by unit of service. 

Due to the close tie between the Licensed Home Care Services Agency Statistical Report and 
the registration process, there is a set of Licensed Home Care Services Agencies that currently 
cannot submit a Statistical Report and register because they did not register, and they owe fees. 
There are two sets of letters informing these agencies of their need to pay the fees they owe 
that are awaiting approval for release. These are Cease and Desist letters and Late Registration 
letters. It is important that these letters be approved as soon as possible in order to provide 
these Licensed Home Care Services Agencies as much time as possible to pay their fees and 
register for the coming year.   

The accompanying material includes the Dear Administrator Letter (DAL) announcing the 
release of the report, the language of Section 3605-b authorizing and defining the registration 
process, and a copy of the new Licensed Home Care Services Agency Registration Short Form 
which will enable appropriate Licensed Home Care Services Agencies to register without 
submitting a full statistical report. 
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INTRODUCTION 
 
Welcome to the documentation for LHCSA (Licensed Home Care Services Agency) and ALP (Assisted Living Program) 
LHCSA Statistical Report using the Universal Data Collection System (UDCS), a data collection tool that enables you to 
enter data for submission to the Department of Health in a spreadsheet-like environment. In the past the platform used 
to collect the Statistical Report information was the Health Electronic Response Data System (HERDS). This has been 
upgraded to UDCS because it offers a more familiar, Excel-like interface and more powerful editing capabilities. 
 
A UDCS data collection application has two parts – the UDCS Report Manager and Shell, which manage the reports on 
your computer and is like the Microsoft Excel executable, and the reports or formats that correspond to spreadsheets. 
This document will guide you through the process of downloading and installing the UDCS Report Manager and Shell and 
the reports. 
 

NOTES:  
• A Health Commerce System (HCS) account is required to download the UDCS Report Manager, Shell, and the 

reports.  

• The Report Manager requires Windows 7 or later operating system. The software WILL NOT operate correctly 
with previous operating systems such as Windows Vista or Windows XP and CANNOT be run on an Apple 
computer. 

• If the UDCS 2018 LHCSA Statistical Report software is installed on your computer, it must be uninstalled before 
this year’s software can be installed. The uninstall can only be done by some one with Windows Administrator 
privileges on the computer. 

• The software, executables and reports, must be installed on the computer of the user who will be entering and 
submitting the data. The user installing the software must have Windows Administrator privileges on the 
computer on which it is being installed.  The Windows Administrator must not use the “Administrator Shortcut” 
– where the user is signed on to the computer, but the Administrator right clicks and chooses “Run as 
Administrator”.  The Administrator must sign on to the computer. 

• Only users who have been assigned the HCS Administrator role when the application is released will be able to 
submit data. Other users can be added afterward but a request must be sent to HCStatRpts@health.ny.gov after 
the user has been assigned the HCS Administrator role. 

• A single data file (this file has an extension of .pnp) should be created for each licensed site that your 
organization operates. 

• A single copy of the data file can be stored in a location where multiple people can access it. This will enable 
people to enter the data that is appropriate for their organizational function – e.g. business office personnel 
entering the cost and revenue data and human resources personnel entering staffing and wages data. 
HOWEVER, ONLY ONE PERSON SHOULD ENTER DATA AT A TIME. If multiple people are entering data at the 
same time, only the data from the last person who saved will be retained. 

  

mailto:HCStatRpts@health.ny.gov
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UNINSTALLING PREVIOUS SOFTWARE 
 
IMPORTANT NOTE:  The Report Manager software has been updated for the 2018 Statistical Report.   If you 
downloaded the software last year you must uninstall the software and re-install the newest version. 
 
To uninstall software: 
 
On Windows 10: 
Go to Settings – Apps 
Click on UDCS Report Manager 
Click Uninstall 

 
 

 
 
 
 
If you are not the administrator on your computer, you may be required to ask your IT Department to do the uninstall 
and installation.   
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Installing the Software, Reports and Documentation 
 

1. Login to the HCS. 
2. Click on Healthcare Financial Data Gateway in My Applications. 
3. If it is not there: 

a. Click on the My Content tab at the top of the HCS home page. 
b. Click on All Applications. 
c. Click on H in the Browse by alphabet list. 
d. Click on the green sphere marked with a plus sign (+) on the row for the Healthcare Financial Data 

Gateway. 
e. Go back to My Content. 
f. Click on Healthcare Financial Data Gateway in My Applications. 

 
 
This will take you to the Healthcare Financial Data Gateway main page.  
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Installing the Software 
 

1. Go to the Healthcare Financial Data Gateway main page. 
2. Click on the Software tab – the Software, Reports and Documentation page will display 

 

 
 

3. Click the Software button– the Download Software page will display. 
 

 
 

4 Select Report Manager and Shell Version 5 (Installation Instructions Included). 
5 Click on the Download button at the bottom of the page. 
6 Save the .zip file to the location of your choice. 
7     Open the .zip file and extract the Report Manager and Shell software and the installation documentation (this 
documentation is more extensive than is required to install the software for the Statistical Report and contains some 
information not applicable to LHCSAs). 
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Installing the Software continued… 
 

8 Run the UDCS_REPORT_MANAGER_SETUP_<version>.exe program. The Installshield Wizard splash screen will 
display after some initializations are performed. Click Next. 
 

 
 

9 The Program Maintenance dialog will display. Select Modify and click Next. 

 
 



pg. 7 
Send questions to hcstatrpts@health.ny.gov 

Installing the Software Continued… 
 
10 The Custom Setup dialog screen will display. Click Next. 

 

 
 

11 The Ready to Modify the Program dialog will display. Click Install. 
 

 
 

12 A Desktop icon will be created named Launch Report Manager V5. Use this to launch the application.  
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Installing the Reports 
Downloading the Reports 
 

1. Go to the Healthcare Financial Data Gateway main page. 
2. Click on the Software tab – the Software, Reports and Documentation page will display. 

 

 
 

3. Click on the Reports button – the Download Matrix Reports page will display. 
a. Organization Type is Home and Community Based Services 
b. Submission Schedule can be Annual LHCSA or Annual ALP_LHCSA 
c. Submission Year is 2018 
d. Submission Period is Annual 

4. Click on the Search button.  
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Downloading the reports continued… 
 

5. Unselect all reports except for the LHCSA-2018 Annual report and click the Download button. 
 

 
 

6. DO NOT OPEN THE .zip FILE.  Save the .zip file to the location of your choice. Some computers automatically 
save the downloaded .zip file into the computers Download folder.  If your computer does not ask where you 
would like to save the file, it has most likely automatically saved the file in the Downloads folder.  Do not modify 
this .zip file – it contains an encrypted file and can only be used by the UDCS Shell. Instructions for managing this 
file with the UDCS Report Manager and using it with the UDCS Shell are contained later in this documentation. 
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Running the Application 
 
Running the application for the first time 
 

1. Click the Launch Report Manager desktop icon. 
2. The UDCS Select a Report dialog will display. Click the Add Downloaded Report button.  

 

 
 

3. Locate and select the report for the LHCSA-2018 annual report that you downloaded earlier  
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Running the Application for the First Time, continued… 

 
4.  Click the down arrow at the end of the Select a Report… drop down menu and click on either the LHCSA 

Statistical Report menu item, or the ALP LHCSA Statistical Report item.   Then select the correct year for the 
report. 
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5. This will load the report into the UDCS Report manager 
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6. Make sure that the correct report is selected and click the Open Selected Report button – the Start 
Report dialog will display 

 

 
 
Running the Application for the First Time, continued… 

7. Click the Start New Report button 
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Running the Application for the First Time, continued… 

 
8. Click the OK button on the Select Report Type dialog – the Configure Report Organization dialog will 

display. Select your LHCSA from the Organization dropdown menu 
 

 
 

9. Select Statewide from the Region dropdown menu click the OK button. 
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Running the Application for the First Time, continued… 

 
10. Click the OK button on the Save Report Configuration dialog. 

 

 
 

11. The Universal Data Collection System Shell will start loading the selected report. 
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Running the Application for the First Time, continued… 

 
12. The Control Data Validation Message dialog will display; click the Yes button. 
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13. File out the General Information data and Click the Validate button. 

 

 
 

14. If the data validates, click the Save button. 
15. Start entering data into the LHCSA Statistical Report or the ALP_LHCSA Statistical Report. 

 
 
Running the application after the first time 
 

1. Click on the Launch Report manager desktop icon  
2. The UDCS Select a Report dialog will display 
3. Click on the down arrow at the end of the Select A Report… drop down menu 
4. Select the LJHCSA Statistical Report menu item 
5. Click on the Open Selected Report button – The Start Report dialog will display 
6. Click on the Open Existing Report button 
7. When File Explorer opens, select the report created when the application was initially started and 

open it. 
8. The Universal Data Collection System Shell will start loading the selected report 
9. If you have not yet entered the Configuration Information data  

a. the Control Data Validation Message dialog will display; click on the Yes button 
b. File out the Configuration Information data 
c. Click on the Validate button 
d. If the data validates, click on the Save button 

10. Continue entering data into the LHCSA Annual Statistical Report 
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Submitting the Finalized Statistical Report 
 

1. Login to the HCS. 
2. Click on Healthcare Financial Data Gateway in My Applications. This will take you to the Healthcare Financial 

Data Gateway main page.  
 

 

 
 

 
3. Click the Submissions tab – the Submissions page will display 
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Submitting the Finalized Statistical Report continued… 

 

4. Select LHCSA or ALP_LHCSA as the Submission Type and your organization from the Organization list and then 
click the Search button. The Submission page will be expanded. 

 

 
 

 

5.  Click the Browse button to display a dialog box that allows you to locate your finalized LHCSA Statistical 
Report. It will have a .pnp file extension.  

6. Once you have selected the file to submit, click the Submit button. 
7. The Submission History section of the Submission page will be updated to reflect the status of the 

submission. 
8. A confirming email message will be sent to the email address listed in the New Submission section of the 

Submission page. 
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Licensed Home Care Services Agency Statistical Report and Registration Forms on Universal Data 

Collection System (UDCS) Instructions 

 

 

Please see Attachment A at the end of this document – it contains descriptions to all items on the tool bars 

located on the top of the Report Manager worksheets. 

 

General Information: 

• Enter information in the blank white fields.  All other fields (pink, lavender, and brown) are read-only 

fields.  You can leave white fields blank if you have nothing to report – you do not have to enter zeros. 

• A few fields are required.  If they are left blank, you will not be able to submit the report.  The field 

header will indicate that the field is required. 

• Some fields require a Yes or No answer.  You must double click on the blank field and choose Yes or 

No from the box.   

• Some forms have validation edits to ensure accurate information is collected.  The validation edits are 

described in these instructions. 

 

Note: This documentation has been updated from the version used for the 2018 LHCSA Statistical 

Report. Dates in the text have been adjusted to reflect this. However, the dates in the graphics have not 

been changed and should be mentally adjusted to reflect the new time period.  

 

To Begin: 

 

Once you have downloaded the Report Manager software and report shell (see the separate downloading 

instruction document): 

 

• To start a new report, click on the Start New Report icon or to resume working on a previously saved 

report click on the Open Existing Report icon. 
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Once you have started a new report or opened an existing report, a box will pop up which is the Configure 

Report Organization.  In this box, you will select your organizations name from the drop-down box in the 

organization line.  If your organization is not listed in the drop-down click on the box that states Organization 

Not found In List for further instruction.  In region section you will have to select statewide.  Then click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You will then see a report configuration box.  Click the Next tab in the bottom right corner. 
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A second report configuration box then appears with the title CheckBox List Panel.  This is where you will 

select the counties that your agency serves.  For example, if you have served patients for this reporting year in 

only three counties you would ONLY pick those three counties in this county list. Once you have done so, 

click the Next tab at the bottom right corner.  
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A third report configuration box will appear once you have completed selecting your counties of service.  

Click Finish in the bottom right hand corner. 

 

                                                

Important Note:  After you have clicked finish, if you need to make a revision to the counties that you 

have selected this can be done by selecting “Configure” and “Report Configuration” from the top tool 

bar.  After you have made the revision, you will be prompted to replace your current .pnp file with the 

revised file.  Click yes to replace the current file.   
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General Information Form 

 

The General Information Form is part of the Report Manager Software and collects information about your 

organization that not only identifies you but enables the submission and certification of your report as well as 

the successful transfer of your data to a data repository.   

 

 

When you open the report, you will receive a pop-up box that requests that you fill in the General Information 

Form.  You must fill in the General Information Form prior to submitting the report. 
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The General Information Form information section will be filled in for you.  You only need to fill in the 

Contact Person and Address sections. 
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Form LSR1 – Agency Form 

 

Form LSR1 - Agency Form collects agency location, contact information and other information.  

 

 

 
 

 

Agency and Contact Information Section 

All fields in this section, except for NPI number, are required fields.  You will not be able to submit the 

statistical report if this information is not filled in. 
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Important Note for ALP LHCSAs –  

The 2019 ALP LHCSA Statistical Report will be posted on the UDCS Platform this year, and will 

include the DOH Registration form. 

 

If your LHCSA serves patients in an Assisted Living Program (ALP) there are two options: 

 

• If your LHCSA serves patients in the community as well as ALP patients, you must submit both the 

2019 LHCSA Statistical Report regarding your community patients and the 2019 ALP LHCSA 

Statistical Report regarding your ALP patients. 

 

• If your LHCSA EXCLUSIVELY serves patients in an ALP program, you only need to submit the 

2019 ALP LHCSA Statistical Report – you do not need to submit any part of the 2019 LHCSA 

Statistical Report. 

 

Agency Information and FIs for CDPAP Sections 

The fields in these sections require yes or no responses.  You must double click on the blank space and the 

box with the choices will appear. 

 

 
 

 

 

Validation Edit – Your answer to the question “Did this agency serve patients during the report year?” on 

row 16 of form LSR1 must match your answer to the question “Did this LHCSA provide patient care services 

during the report year of 1/1/2019 – 12/31/2019?” on row 4 of form LSR10.  
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Form LSR2 – Patient Form 

 

Form LSR2 - Patient Form collects patient demographic information, including discharges and referrals.  

 

 
Some of the totals on this form are automatically calculated – they are the lavender fields. 

 



Send questions to hcstatrpts@health.ny.gov   pg. 11 
 

Patients Section 

Enter information for Patient Census.  Enter the patient census as of December 31 of the report year 

(12/31/2019).  Patient Census means the actual number of individual patients receiving services on 12/31/19. 

 

Next, enter the total number of cases in the Total Cases field. A case is an episode of care with a start date 

(admission) and an end date (discharge).  Multiple types of service may be provided during an episode of 

care.  For an episode of care to count as a case for this report the admission date must be in this reporting year 

or prior year(s), and the discharge date must be in this reporting year or the patient must still be receiving 

services at the end of the reporting year.  A patient who has been seen only to be assessed for personal care 

services should not be counted as a case and these visits should not be reported.   

 

A patient sometimes represents more than one case.  However, DO NOT count a patient as a new case if any 

of the following conditions apply: 

• The patient’s age category was changed during the report year 

• The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with 

the same illness or diagnosis.  In this instance the discharge should not be counted. 

• The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently 

established. 

 

Validation Edit - The number of cases entered on row 2 of LSR2 must match the total of the “Referred 

From” column on row 30 of LSR2. 

 

Enter the Unduplicated Patient Count in the next field.  This is the total number of discrete individual 

patients that your agency has served in the year, regardless of the number of admissions and discharges that 

patient may have had.   A patient is only counted once regardless of the number of cases they represent. 

 

To recap, if a patient is receiving care on 12/31/2019 they will be included in the patient census count. If they 

had two admissions during the year, they will count as two cases but as only one unduplicated patient.  

 

Validation Edit - The unduplicated patient count entered on row 3 of LSR2 must match the total of the 

unduplicated patients reported on forms LSR7 – Services by County Form.  This total is displayed on row 999 

in the first section of LSR2 – Patient Form. 

 

Length of Stay Section 

Length of Stay (LOS) information is entered in the next section. LOS is calculated for each episode of care or 

case. Length of stay should be calculated from the date the patient was initially admitted for an episode of 

care, regardless of the year of admission, to the date they were discharged.  For example, if a patient was 

admitted on 12/30/2018 and discharged on 1/10/19 her LOS is 12 days.  Count the 2 days in 2018 and the 10 

days in 2019 to arrive at a 12 day LOS.  Patients that were discharged to a hospital or RHCF and readmitted to 

the agency within 30 days with the same illness or diagnosis should NOT be counted in the length of stay 

section. 

 

Validation Edit - The total number of discharges calculated from the LOS entries on row 10 of LSR2 must 

match the total number of discharges calculated from the “Discharged To” section on row 30 of LSR2. 
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Referrals and Discharges Section 

The next section collects patient referral and discharge information. In the “Referred From” column enter the 

number of cases served by your agency that have been referred from each of the designated sources regardless 

of their start of service date. This means that if you are serving a case in 2019 that was referred to your agency 

in 2018, that case should be counted.  Patients that were discharged to a hospital or RHCF and readmitted to 

the agency within 30 days with the same illness or diagnosis should not be counted in the discharge section.  

 

In the “Discharged To” column enter the number of cases discharged during the reporting year to specific 

destinations.  
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Form LSR3 and LSR4 – Revenue Form 

 

Form LSR3 and LSR4 – Revenue Form has two sections  

 

LSR3 – Contract Revenue Form collects information about revenue received from contracts with other 

agencies to perform services for their patients or provide equipment to their patients. 

 

LSR4 – Direct Revenue Form collects data on revenue from services provided to patients directly served by 

your agency (i.e. services are not provided on behalf of another agency).  Direct services may include private 

pay, commercial insurance, and worker’s compensation cases. 
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Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

Please note that data on Nursing Services is collected as visits, instead of hours.  If your agency records 

Nursing Services in hours, please count 2.5 hours as 1 visit. 

 

Contracted Services Section 

Begin by answering the Perform Services Question - If your agency DID NOT perform services for, or 

provide equipment to, the patients of other agencies under contract during the report year, answer the first 

question “no” and move down to the Direct Services section of the form.  You may leave the columns blank 

and do not need to enter 0s in these columns.   

 

If your agency DID perform services for or provide equipment to the patients of other agencies under 

contract, enter “yes” for the first question. Enter the number of contract hours and revenue by the type of 

service if you have contracted with another agency, usually a CHHA or an MLTC plan, to provide service on 

their behalf.   

 

Direct Services Section 

Enter the number of hours and revenue by the type of service.   

If your agency did not provide any services directly to any patients, leave the columns blank (you do not have 

to enter 0s). 

 

For both the Contracted Services and the Direct Services - the Gross Revenue is the total revenue received 

for the services or equipment provided before any deductions or allowances. 
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Validation Edit – If there is an entry made in the hours or visits column, there must be a corresponding entry 

made in the gross revenue column.  
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LSR5 – Cost Form 

 

LSR5 – Cost Form - collects data on costs for providing services to patients.  Costs are divided into direct 

and indirect costs.  

 

Direct costs are costs that are clearly associated with the provision of home care patient services. Examples of 

direct costs are staff wages, transportation costs, consumable supplies such as gloves and masks, and the cost 

of providing in-service training to aides.  

 

 
 

 

Indirect costs are fringe benefits and payroll taxes as well as costs for activities and materials that are used by 

the entire agency.  

 

The indirect costs are broken out by fringe benefits and other indirect costs, such as administrative and 

general costs, capital and related costs, and other operating costs. 
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• Administrative and General costs are expenses for activities and materials that are used to administer 

your business. Examples are rent, utilities, and office supplies. 

• Capital and Related costs are onetime costs for construction, major repairs to real estate owned by the 

agency, etc. 

 

 
 

 

Some of the totals on this form are automatically calculated – they are the lavender fields. 
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LSR6 – Staff and Wages Form 

 

LSR6 – Staff and Wages Form - collects information by staff type for full time and hourly staff at two 

different dates during the reporting year and the total number of W2s issued, hours worked, wages, and fringe 

benefits.   

 

 
 

 

Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

Enter the number of full-time and hourly staff at your agency on April 1 and October 1. The current definition 

of a full-time staff is someone who works an average of 30 or more hours a week and 130 hours or more per 

month.   

 

Validation Edit – the number of HHAs entered in each of the 4 first columns must not exceed 17,000. 

 

Validation Edit – the number of PCAs entered in each of the 4 first columns must not exceed 17,000. 

 

Enter the number of W2s issued during the year for each staff type. 

 

Validation Edit – the total number of W2s must not exceed 25,000. 

 

Enter the total hours worked, total wages paid, and total fringe benefits paid for each staff type.  The amount 

of wages plus fringe benefits will be calculated in the first lavender column.  The second lavender column will 

divide the total wages (not including fringe benefits) by the total number of hours to calculate an average 

hourly wage.  In the next two columns, enter the lowest hourly rate paid and the highest hourly rate paid for 

each staff type. 
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LSR7– Services by County Form 

 

LSR7 – Services by County Form - collects data on services provided by county.  There is a sheet for each 

county that you chose when you started the report.  The LSR7 worksheets were put at the end of the list of 

worksheets on the left-hand side of the screen. 

 

 
 

Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

For each County that your agency provides services: 

 

Enter the number of unduplicated patients in each of the four age/sex cohorts: 

• Under age 21 

• Age 21-64 

• Male Age 65+ 

• Female Age 65+ 

These amounts are automatically calculated in the lavender field in the first column. 

 

Enter the number of new admissions during the report year.  

 

Validation Edit - The amount entered as new admissions must be less than or equal to the unduplicated 

patient count. 

 

An unduplicated patient is an individual who has received at least one episode of care and may have 

received more than one.  Regardless of the number of episodes in the reporting year, the individual is only 

counted once. Differently from last year we are asking for the unduplicated patient count to be broken out in 

age/sex cohorts of age groups.  Please count the age of the patient at the first episode of service (if service was 

initiated during the report year), or if the patient started service in a prior year count their age at the beginning 

of the year. 
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New admissions are patients that have been admitted to the agency during the reporting year.  Patients that 

were admitted at a previous time during the report year (or in prior years) and discharged and were admitted 

again during the report year should count as a new admission at the time of admission, with the following 

exceptions: 

DO NOT count a patient as a new admission if any of the following conditions apply: 

• The patient’s age category was changed during the report year 

• The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with 

the same illness or diagnosis.  In this instance the discharge should not be counted. 

• The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently 

established. 

 

Nursing services captures data about nursing services provided to patients in the selected county. The data is 

then broken out by cases and visits, age, and gender (for ages 64+).  If your agency records Nursing Services 

in hours, please count 2.5 hours as 1 visit.  In addition, if your agency is part of the Nurse Family Partnership 

– the number of nursing service cases and visits should be recorded in the selected county.  The Nurse 

Family Partnership is a program in which nurse home visitors work with low-income young women who are 

pregnant with their first child, helping these vulnerable young clients achieve healthier pregnancies and births, 

stronger child development, and a path toward economic self-sufficiency. 

 

All other services provided to patients in the selected county must be recorded below the Nursing Services 

row. The data is then broken out by cases and hours, age, and gender (for ages 64+).   

 

A case is an episode of service with a start date (admission) and an end date (discharge).  Multiple services 

may be provided during an episode of service.  For an episode of service to count as a case for this report the 

admission date must be in this reporting year or prior year(s), and the discharge date must be in this reporting 

year or the patient must still be receiving services at the end of the reporting year.  A patient who has been 

seen only to be assessed for personal care services should not be counted as a case and these visits should not 

be reported.   

 

A patient sometimes represents more than one case.  However, DO NOT count a patient as a new case if any 

of the following conditions apply: 

• The patient’s age category was changed during the report year 

• The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with 

the same illness or diagnosis.  In this instance the discharge should not be counted. 

• The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently 

established. 
 

Validation Edit -   If you enter an amount in the “Cases” column you must enter an amount in the 

corresponding “Hours” column.  Also, if you enter an amount in the “Hours” column, you must enter an 

amount in the corresponding “Cases” column. 

 

Validation Edit - If you enter amounts in the cases columns you must have an amount entered in the 

unduplicated patient count.  Conversely, if you have an unduplicated patient count, you must have amounts 

entered under cases.  



Send questions to hcstatrpts@health.ny.gov   pg. 21 
 

LSR7A – Wellcare  Form 

 

LSR7A – Wellcare Form - collects data about Wellcare services provided to patients. Wellcare services 

include services which have as their primary purpose the prevention of illness and obtaining optimum health 

for their recipients.  Examples of such services are nurses performing lead screening assessments, providing 

maternal and child health education, or following up on communicable diseases.   

 

Only County-Operated LHCSAs that provided wellcare services need to complete this form. 

 

 
Some of the totals on this form are automatically calculated – they are the lavender fields. 
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Nursing services captures data about nursing services provided to patients in the selected county. The data is 

then broken out by cases and visits, and gender.  If your agency records Nursing Services in hours, please 

count 2.5 hours as 1 visit.   

 

Private Duty Nursing Services captures data about nursing services provided to patients in the selected 

county. The data is then broken out by cases and hours, and gender.    
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LSR8 – Contracts  Form 

 

LSR8 – Contracts Form - collects information on your agency’s contracts to provide services on behalf of 

another agency.  

 

 

 
 

 

If your agency did not have any contracts to provide services for another agency, answer No to the first 

question, and you are now finished with this form. 

 

If your agency did have contracts to provide services on behalf of another agency, answer Yes to the first 

question, and enter the information for the contract(s).  

 

If it is available, enter the license number/operating certificate number for the agency with whom you are 

contracting. CHHAs and Hospices will have operating certificate numbers. Other organizations may not have 

an operating certificate number.  Enter N/A if the organization does not have an operating certificate or 

license number. 

 

Operating Certificate numbers can be found in the Home Care section on the Profiles webpage 
https://profiles.health.ny.gov/home_care/index.  Hover the mouse at the Home Care tab and you will see 

several ways to search for an agency.  Once you find the agency you are looking for, click on the overview tab 

and open the administration section.  

 

Enter the number of HHA and PCA hours of service you provided under this contract and the amount your 

agency was paid per hour of service.  

 

If the requested information for a given contract changed during the reporting year, enter it as two or more 

separate contracts. 

 

  

https://profiles.health.ny.gov/home_care/index
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LSR9WFA – Workforce Form A 

 

LSR9WFA – Workforce Form A - collects information on admissions and the number of cases by 

authorized hours per week for all services. 

 

 

 
 

An agency is closed to admissions when the agency is not accepting any new patients.  This would not 

include times during the reporting year when an agency receives a referral list, fills cases it is able to, and 

does not take cases it is unable to.  However, if the agency is not accepting any new cases due to reasons such 

as staffing and scheduling constraints, it should be included in this count.  Do not include days, such as 

holidays, if the agency would not normally accept a new case on that day. 

 

An agency is unable to fill the total hours approved for a case if the case is approved for a certain number 

of hours, but the agency is not able to fill the total number of approved hours with its current workforce for 

any reason.  Cases that are unfilled because someone calls out of work one day should not be included in the 

response.  
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LSR9WFB – Workforce Form B 

 

LSR9WFB – Workforce Form B - collects information on number of staff employed and assigned to cases, 

and the number of open positions at two points during the year.  This form also collects the number of staff 

that have been employed by your agency for the full report year and the number of staff that have left your 

agency during the report year. 

 

 
 

The number of staff employed on April 1 and October 1 is totaled (count of full time staff plus count of hourly 

staff) and forwarded from form LSR6 – Staff and Wages Form.   

• Enter the number of staff assigned to cases on April 1 and October 1.  This means staff that have cases 

assigned to them as of that date, not just staff actually working a case on that date.  For staff not 

providing direct care, such as administrators or administrative staff, enter a “0” in the response. 

• Enter the number of Open positions on April 1 and October 1.  A position is considered open when an 

agency has advertised for a position, but it is not filled.  This includes both hourly and full time 

positions.  If an agency is continuously recruiting for any of the job categories, it should quantify the 

number of workers it would need to hire to be considered fully staffed in that category. 

• Enter the number of staff (full time and hourly) that have remained employed by your agency for the 

full report year or more.   If an employee is terminated and rehired during the report year, they should 

not be included in this total. 

• Enter the number of staff (full time and hourly) that have left your agency (no longer employed by 

your agency) for any reason during the reporting year.  This is a count of workers who left their 

position for any reason – voluntary or involuntary – excluding promotions.  
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LSR9WFC – Workforce Form C 

 

LSR9WFC – Workforce Form C - collects employee benefit information for four types of employees, and 

non wage supports for all staff. 
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Employees that receive health insurance or retirement plan benefits through the union, if the agency pays into 

the benefit, should be counted as enrolled in employer-provided health insurance or employer-sponsored 

retirement plan.   

Short-term disability insurance may include the required coverage under New York State law or supplemental 

coverage that the agency offers.  
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LSR10 – Registration Form  

 

LSR10 – Registration Form - collects an attestation that indicates the LHCSA is currently operational and 

serving patients.  If the LHCSA has opened in the past year, you can report on the form that the LHCSA is not 

yet operational and is currently not seeing patients.    

 

Some fields on this form are required fields.  You will not be able to submit the statistical report if this 

information is not filled in. 

 

The appropriate Governing Authority Representative must request that the LHCSA be registered with the 

Department of Health for the upcoming calendar year.  
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Validating the Statistical Report 

 

You may, at any time, Validate the Sheet you are working on, or validate the entire Report.  You must 

validate the report before submitting it. 

 

Go to the top tool bar and click on the drop down box next to the green arrow. 

 

 
 

 
 

You can validate a worksheet at any time.  You can also refresh the validation after it’s been done once by 

clicking the refresh circle in the details portion of the report.  Because there are so many worksheets, it may 

be easier to validate each worksheet once you’ve finished it.  The results of the validation are in a table in the 

details section of the worksheet.  The message that says “Rule Passed Validation” is only referring to the cell 

you are on – not the whole worksheet. 

 

 
 

 

The details section is automatically set up to show all rules.  It’s only an error if there is a checkmark in the 

error box 

 

 
 

 

To see if you have any cells with errors – click on the filter in the details section and change it from “all rules” 

to “critical errors”. 

  

 
 

 

 

 



Send questions to hcstatrpts@health.ny.gov   pg. 30 
 

 

Validations can be done for the worksheet you are on by checking the box that says “Current Worksheet” or it 

can be done for all worksheets by unchecking the box.   

You can fix an error and then re-run the validation by clicking on the refresh circle. 

 
 

 

If you have passed the validation edits you will have no error boxes checked and get a green message that 

says Rule Passed Validation for each cell you choose. 

 

Finalizing the Statistical Report 

 

If you have passed all the validation edits, and you are satisfied with all responses on all forms, click on the 

Finalize Report icon. 

 

 
 

 

Or click Action on the top tool bar and choose “Finalize Report” 

 

 
 

 

A message will come up asking if you are sure you want to save and finalize.  Click Yes. 

A second message will come up directing you to correct errors (if there are any) or letting you know that the 

report has been finalized. 

 

Select a location to save your Finalized Report. Make sure that you are aware of where it is being saved 

(i.e. desktop) as you will need to find the file when you upload it onto the Healthcare Financial Data 

Gateway.  You may wish to make a new folder on your desktop and save it there. 

You will save a PDF of the report, as well as a .pnp file of the report. 

 

The name of the report will be: 

LHCSA_Agency Name_(Agency License Number)_Statewide_2019_A00.pnp 

 

The file you will want to upload will end in “.pnp” 

 

Your report is now ready to be submitted to the Healthcare Financial Data Gateway. 
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Submitting the Finalized LHCSA Statistical Report to the Healthcare Financial Data Gateway 

 

1. Login to the HCS.  

2. Click on Healthcare Financial Data Gateway in My Applications. This will take you to the 

Healthcare Financial Data Gateway main page.  
 

 

 
 

 
3. Click the Submissions tab – the Submissions page will display 

 

 
 

4. Select LHCSA as the Submission Type and your organization from the Organization list and then 

click the Search button. The Submission page will be expanded. 
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5. Click the Browse button to display a dialog box that allows you to locate your finalized LHCSA 

Statistical Report. It will have a .pnp file extension.  

6. Once you have selected the file to submit, click the Submit button. 

7. The Submission History section of the Submission page will be updated to reflect the status of the 

submission. 

8. A confirming email message will be sent to the email address listed in the New Submission section of the 

Submission page. 
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Attachment A – Report Tool Bar items 
 

Worksheets 

Worksheets 

 

The Worksheets are listed in the Worksheet Panel which is located on the left side of the application 

window. Worksheets are listed in alphanumeric order by Worksheet name. Click on a Worksheet to view 

that Worksheet in the Matrix Panel. Click on the small arrow key in the top right of the Worksheet Panel to 

collapse or expand the panel. Use the "Windows" menu item to organize your Worksheets in the Matrix 

Panel. 

Title Bar 

Title Bar 

 

The Title Bar is located at the very top of the window and will display the name, version and software build 

number, followed by the name of the active matrix table if a table is currently open. 
 

Menu Bar 

UDCS Menu bar 

 

The following Help Topics will guide you through the menu bar functionality. 

 

File 

The File Menu. 
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Report Manager: Select Report Manager to return to the Report Manager.  

 

New: This command will start a new Report 

 

Open: This command will enable you to open an existing Report 
 

Save: This will save the Report you are working on. 

 

Save Copy To: The Save Copy window will open and enable you to save a copy of your Report to a location 

that you choose. 

Your working report location will remain in the default location: C:\ProgramData\UDCS\report 

 

Print: Two options will be displayed that will enable you to save your Report as a Microsoft Excel 

document or a PDF document. 

For either option, the Select Worksheets window will open. Check the worksheets you wish to export or 

check Select All to check all of the worksheets. 

You will be prompted to save the export file to a location you choose. You can then open the file from this 

saved location and print. 

 

Close Report: Closes the Report. You will be prompted to save your data first. 

 

Exit Program: Closes the UDCS software and the Report Manager. You will be prompted to save your data 

first. 
 

Edit 

The Edit Menu 

 
Cut, Copy, Paste, Undo 

 

 

These features will enable you to copy data from one part of your report to another, or from Microsoft Excel 

to your Report with some limitations: 

1) You may copy numeric data to numeric or non-numeric type cells. You may not copy non-numeric data to 

numeric type cells. 

 

2) You may not paste data into read only cells such as targets of formulas. 

 

3) You may select a range of cells to copy. However, when you paste the cells, the range size must match. If 

the range size does not match, you will not be allowed to copy the data. 
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For example, if you copy a 5 cell by 5 cell range and try to paste in a 3 cell by 3 cell area, or the area has 

read only cells, you will be alerted to adjust your range. 

 

View 

The View Menu 
 

 
 

Report Type: You can choose to Select All Worksheets to display all of the worksheets in the Report in the 

Worksheet display panel. 

For Reports that have multiple Report Types, you may choose to select only the worksheets from the 

selected Report Type. 

 

Worksheet Panel (Expand-Collapse): Expands or collapses the worksheets panel. It may be convenient to 

collapse the worksheet panel 

when you are working on a large worksheet and could use extra space to see more of the worksheet. 

 

With the worksheets collapsed you may also click on the arrow icon where the worksheets are collapsed to 

expand the worksheets. 

Previous Worksheet and Next Worksheet: Use these commands to navigate through the worksheets. 

 

Detail Pane (Expand-Collapse): Use this command to expand or collapse the Details panel. This works 

similarly to 

expand-collapse worksheets. 

 

The following menu items will each open a window that will enable you to Export the data as a text file. 

Calculations: A window will open that lists all of the mathematical expressions in the Report. 

 

Text Transfers: Lists all of the Text Transfers in the Report. 

Text Transfers consist of a value and a target. Once the value is entered, the target will 

automatically get populated with the same value. 

 

Validation Rules: Lists all of the Validation Rules in the Report. 
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Validation Rules are conditions that must be met in order for the report to be completed 

satisfactorily. 

 

Submission Output: This is the XML output of the Report. It lists Report configuration information 

as well as class code/line numbers and the values that were entered for them. 

 

Configure 

The Configure Menu 

 
 

Control Data: Contains information that is required in order for the Report to be completed correctly and 

allowed to be submitted. 

All required Control Data fields must be complete. Required fields will have a red exclamation point next to 

them. 

When you open the Report, you will be alerted if the Control Data information is not completely filled out. 

 

Report Settings / Report Types: These menu items are merely instructions to remind you what to do in the 

event that you have created 

your report using the wrong configuration information, such as the wrong Report Type or wrong Region. Click 

on the File menu to 

Start a New Report. Select the correct settings and then transfer your data from the incorrect Report to the 

new Report. 

Action 

The Action Menu 
 

 

Validation Method: Current Worksheet or Entire Report. 

In order to Finalize the Report for Submission you must run it through the validation process. You can 

validate to check only 

the current Worksheet or you can run Validation for the entire Report. You must Validate the entire Report in 
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order to 

pass Validation and have a Finalized Report that is ready to submit. 

 

Start Validating/Stop Validating: Once you have selected to validate the current Worksheet or the entire 

Report you can 

select the Start Validating item. For larger Reports, you may choose to Stop Validating at any time. 

 

Notepad 

The Notepad Menu 

 

This is a scratch pad to keep notes and provide additional information while you complete your report. Click 

the File menu and then Save to save Notes to your Report. 

Use the File and Edit menu as you would a typical text editor. 

Windows 

The Windows Menu 
 

Use the Windows commands to arrange the Worksheets to your satisfaction. 

Select the Worksheets command to see a list of opened Worksheets. You may select an open Worksheet to 

bring it to the front of the Report. 
 

 

Search 

The Search Menu 

 

Enter what you would like to search for in the Search box and click the Search button. 

All results that match your Search criteria will be listed below. You may choose to Search 

the Current Worksheet or All Worksheets by toggling the radio buttons at the bottom of the window. 

Help 

The Help Menu 

 

View Documentation will open the Help File that you are currently reading. 
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Click About to open the following window. This information contains details about the Report you have open 

as well as the versions of the software and files being used. 
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Icon Menu 

 
Icon Menu 
 
 
 
 

        Open the Control Data Form. 
 
 
 
 

         Start a New Report. 
 
 
 

       Open an Existing Report. 
 
 
 
 

        Save the Report. 
 
 
 
 

        Close the Report. 
 
 
 
 

        Validate the Current Worksheet or the Entire Report. 
 
 
 
 

        Stop the Validation process. 
 
 
 
 

        Finalize the Report. 
 
 
 
 

        Open Notepad. 
 
 
 
 

        Open the Previous Worksheet. 
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         Open the Next Worksheet. 

 
 
 
 

         Export the Worksheet as a PDF document. 
 
 
 
 
 

         Export the Worksheet as an Excel file. 
 

          Open the Search Window. 
 

 



2019 Licensed Home Care Services Agency Statistical Report Frequently Asked 

Questions 

 

 

Q:  Do we combine FI (Fiscal Intermediary) and LHCSA (Licensed Home Care Services 

Agencies) information if we operate both programs? 

 

A:  If you operate both a LHCSA that serves the community and you are a Fiscal Intermediary 

(FI) for the CDPAP program you must separate all FI information out from the LHCSA 

information. The FI should be run as a distinct line of business from the LHCSA. 

You should indicate on form LSR1 that you are an FI.  You should fill out all other information on 

the Statistical Report regarding the patients you serve in the community and staffing information 

should be in regard to the LHCSA activities only. 

 

If your LHCSAs is exclusively an FI, you will have no patient information to report, but you 

should fill out ALL forms for which they have information, including staffing levels, salary, etc.  

 

 

Q. Where can I find instructions and documentation for the 2019 LHCSA Statistical Report? 

A. Sign on to the Health Commerce System (HCS) 

     Click on: 

• My Content on the top purple tool bar 

• Documents by Group 

• View all Document Groups 



• Long Term Care 

• Training 

• Home Care 

• LHCSA Statistical Report 

 

Q:  Our Agency was not open in 2019 – do we need to submit a report? 

 

A:  If your agency was newly opened in 2020, you may register using the LHCSA Registration 

Short Form HERDS survey. You will need to send a note to HCStatRpts@health.ny.gov 

requesting access to the survey. Once this request is received, DHCBS staff will work with to 

register your LHCSA.  

 

 

Q:  Our Agency was open in 2019, but did not serve patients – do we need to submit a report? 

 

A:  You must complete and submit the 2019 LHCSA Statistical Report to register your agency 

with the Department of Health.  You must fill out the contact information on form LSR1 Agency 

Information Form and fill out form LSR10 Registration Form entirely.  If your agency has staff, 

you must complete and submit forms regarding Staffing and Wages, Costs and Workforce. 

 

 

Q:  Our Agency is an ALP (Assisted Living Program) LHCSA (Licensed Home Care Services 

Agency) that exclusively serves patients of an Assisted Living Program.  What needs to be 

submitted? 

 

mailto:HCStatRpts@health.ny.gov


A:  LHCSAs that EXCLUSIVELY serve patients in an Assisted Living Program (ALP) are only 

required to submit the 2019 ALP LHCSA Statistical Report Form. 

 

If your agency is a LHCSA that serves ALP residents and also serves patients in the 

community, you must complete and submit all forms on the 2019 LHCSA Statistical Report in 

regards to your patients in the community AND the 2019 ALP LHCSA Statistical Report in 

regards to the patients in the Assisted Living Program. 

 

 

Q:  I do not have access to the 2019 LHCSA Statistical Report on the Healthcare Financial Data 

Gateway.  What can I do? 

 

A:  People who were able to access the Healthcare Financial Data Gateway last year to 

download the software and submit the report continue to have access this year.   If you are in 

the Administrator role and you are unable to access the Gateway, please send an email to 

hcstatrpts@health.ny.gov.  If you are not in the Administrator role on the Health Commerce 

system – you should discuss with your administrator what they would like to do regarding giving 

you access to the report. 

 

 

Q. Do I have to be assigned the Administrator role to enter data into the 2019 LHCSA Statistical 

Report? 

 

A. No. Once the software is installed on a computer and the Report format is loaded, anyone 

with access to that computer can enter data. However, only someone assigned the 

Administrator role can submit the report.  

mailto:hcstatrpts@health.ny.gov


 

 

Q. My agency has multiple people assigned the Administrator role who are also registered with 

the Healthcare Financial Data Gateway so that they can download the software and report and 

can submit the final report. Should they all download a copy of the application and report? 

 

A. The answer is it depends. They can each download and install the software on their 

computer, but care must be taken that all of them only enter data into a single, shared copy of 

the report. If they enter data into private copies of the report, the private copies cannot be 

merged. If they submit private copies of the report, only the data from the last submitted copy 

will be available. See the next question.   

 

 

Q. How can multiple people enter data into a LHCSA Statistical Report? 

 

A. You may want to have different people fill out different parts of the LHCSA Statistical Report. 

For example, you may want someone from your fiscal unit to fill out the cost and revenue 

sections, someone from human resources fill out the staffing and workforce sections and 

someone else enter the patient and service data. This can be done in different ways, but care 

must be exercised so that only one person is entering data into a report at a time. If more than 

one person enters data into a report at the same time, only the changes made by the last 

person to save their copy of the report will be retained. 

 

The simplest way to have multiple people work on the LHCSA Statistical Report is to install the 

application on a single computer and have people use that computer to enter data into a report 



stored on the computer. This enforces the requirement that only one person enter data at a 

time.  

 

Another method for multiple input to the report would be to install the application on the 

computers of everyone who will be entering data. The application and report can be 

downloaded once, stored on a file server or flash drive, and then installed from the server or 

flash drive onto the computers of all the people who will be entering data.  

 

One person should then create and save the initial instance of the report for a license. The 

default location for this file (which has a .pnp extension) will be in the My Documents\UDCS 

folder of the person who created the report. A copy of this file can then be placed on a file 

server where it can be accessed by those who have had the application installed on their 

computer.  

 

Only one person should enter data into the report at a time. If more than one person enters 

data into a report at the same time, only the changes made by the last person to save 

their data will be retained. Also, everyone must enter data into this one report. Data entered 

into other copies of this report cannot be merged into this one report and will have to be re-

entered. 

 

Alternatively, the initial instance of a LHCSA Statistical Report can be stored on a single flash 

drive which can be given, in succession, to each person who will be entering data. These 

people must have the LHCSA Statistical Report application installed on their computers. All 

people entering data must save it to the same flash drive; there is no way to merge data 

entered into multiple instances of a LHCSA Statistical Report into a single copy. 

 



 

Q:  I’ve downloaded the Report Manager software, but I get an error message when I try to 

install it on to my computer.  What can I do? 

 

A:  You may not have the privileges needed to install software on your computer.  You may 

need to contact your IT Department and have them install the software on your computer.  

Please note that the Report Manager software requires Windows 7 or later operating system.   

 

 

Q:  I’ve tried to download the Report Manager software on my Mac computer, and it does not 

work.  What can I do? 

 

A:  Report Manager software requires Windows 7 or later operating system.  It will not work on a 

Mac.  You must use a computer that has Windows to submit your 2019 LHCSA Statistical 

Report. 

 

 

Q. I have downloaded and installed the software, but when I download the Report and try to 

open the downloaded file, I get a prompt for a password or an error message that says the file 

may be damaged. How can I download the Report? 

 

A. The file containing the LHCSA Statistical Report matrix is a .zip file that contains an 

encrypted file. Depending upon how your browser is configured, it may attempt to open the .zip 

file for you. You do not need to open this file and extract the contents; you should save it where 

you can locate it and load it into the Report Manager. 

 



 

Q: I have completed the report and finalized and saved it.  When I go to upload the report on the 

Healthcare Financial Data Gateway, I get the error message that says I cannot upload a PDF 

file.  What do I need to do? 

 

A:  When you finalize the report and are asked to save it, the software will save both a PDF 

version of the file and a PNP version of the file.  You must upload the PNP version. 

 

FAQs about the Forms: 

 

LSR2 

 

Q: What is meant by census? 

 

A: Census is the number of patients being served at a particular point in time.   

 

Q: What is meant by cases? 

 

A: A case is the provision of a course of services to an individual from a starting point to an 

ending point.  A patient can have multiple courses of service and can consequently contribute 

more than once to the total number of cases. 

 

Q: What is meant by unduplicated patient count? 

 



A: The unduplicated patient count is the number of discrete individuals provided with home 

care services.  A patient is counted only once regardless of the number of cases that they 

represent. 

 

 

LSR3 – Contract Revenue Form, and LSR4 – Direct Revenue Form 

 

Q: What is meant by revenue? 

 

A: Revenue is income, or monies coming into your agency.   

 

Q: What is the difference between contract revenue and direct revenue? 

 

A:   Contract revenue is the income your agency received for services provided to patients 

because of a contract your agency has with another agency.  Direct revenue is the income your 

agency received for services provided to the patients that are directly under the care of your 

agency. 

 

Q:  Our LHCSA has staff that are paid by a grant.  Should this be included as revenue? 

 

A:  Yes.  Grant money should be included as revenue. 

 

 

LSR5 – Cost Form 

 

Q: If certain costs fall into two categories, should they be listed twice? 



 

A: No.  Do not double count costs.  Choose one of the cost categories and enter the cost 

only once. 

 

Q:        Do costs related to the delivery of services include the wages paid to the                                                                                               

employee giving the services? 

 

A: Yes. Include Wages in the costs on LSR5 – Cost Form. 

 

Q: What is included under fringe benefits? 

 

A: Fringe benefits are employment benefits granted by an employer that has monetary 

value but does not affect basic wage rates.  Fringe benefits may include health insurance, vision 

and/or dental insurance, paid holidays, pension, or items such as uniforms or a company car. 

 

Q:   We pay HHAs/PCAs bereavement, jury duty, overtime, Paid Time Off (PTO), holidays, 

travel time, annual medical exam time, in service/special training time etc.  Are these 

considered fringe benefits? 

 

A:  Yes.  These items can be included as fringe benefits on forms LSR5 Cost Form and the 

LSR6 Staff and Wages form. 

 

Q: What is meant by Administrative and General Costs? 

 



A: Administrative and General Costs are expenditures related to the day-to-day operations 

of a business.  These costs pertain to the operation of the business rather than the cost for 

services to patients.  Examples include rent, utilities, and office supplies. 

 

Q: What is meant by other operating costs? 

 

A: Other operating costs are costs that are not included elsewhere. 

 

Q: What is meant by Capital and related costs? 

 

A: Capital and related costs are fixed, one-time costs incurred for the purchase of land, 

buildings, or construction.  Building improvement costs that add to the value of the property are 

included in capital costs.  Maintenance of buildings and property are not included in capital 

costs. 

 

Q:  Our LHCSA does not have staff – we contract with a CHHA.  Where do we enter the 

expense of payments to a CHHA for the staff that we use? 

 

A:  Enter the costs on LSR5 – Cost Form.  There are lines for recording the costs of providing 

different services. If you are paying the CHHA for staff to provide services, that cost should be 

recorded here. 

 

 

LSR 6 – Staff and Wages Form 

 

Q: What is meant by full time employee and hourly employee? 



 

A:  The IRS defines a full-time employee as an employee who works on average at least 30 

hours per week, or 130 hours per month.  Employees that work less than this should be 

considered hourly. 

 

Q:  When entering the highest and lowest hourly rate for HHAs and PCAs – do we have to take 

in consideration the overtime rates or weekend/mutual case differential when it comes to the 

highest rate? 

 

A:  No. Do not include overtime rates or weekend/mutual case differentials when determining 

the highest hourly rate.  Also do not include fringe benefits that bring the wage up to the wage 

parity amount. 

 

 

LSR7 – Services by County 

 

Q:  What is meant by unduplicated patient count? 

 

A:  The unduplicated patient count is the number of discrete individuals provided with home care 

services.  A patient is counted only once regardless of the number of cases that they represent. 

 

Q:  What is meant by New Admission? 

 

A:  New Admissions are patients that have been admitted to the agency during the report year. 
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ALP LHCSA Statistical Report and Registration Forms on Universal Data Collection System (UDCS) 

Instructions 

 

Submit this report with information regarding the residents your LHCSA (Licensed Home Care Services 

Agency) serves in the ALP (Assisted Living Program) only.   If your LHCSA also serves patients in the 

community, you must also submit the LHCSA Statistical Report.   

 

Please see Attachment A at the end of this document – it contains descriptions to all items on the tool bars 

located on the top of the Report Manager worksheets. 

 

General Information: 

• Enter information in the blank white fields.  All other fields (pink, lavender, and brown) are read-only 

fields.  You can leave white fields blank if you have nothing to report – you do not have to enter zeros. 

• A few fields are required.  If they are left blank, you will not be able to submit the report.  The field 

header will indicate that the field is required. 

• Some fields require a Yes or No answer.  You must double click on the blank field and choose Yes or 

No from the box.   

• Some forms have validation edits to ensure accurate information is collected.  The validation edits are 

described in these instructions. 

 

To Begin: 

 

Once you have downloaded the Report Manager software and report shell (see the separate downloading 

instruction document): 

 

• To start a new report, click on the Start New Report icon or to resume working on a previously saved 

report click on the Open Existing Report icon. 

 

 

Note: This documentation has been updated from the version used for the 2018 LHCSA Statistical 

Report. Dates in the text have been adjusted to reflect this. However, the dates in the graphics have not 

been changed and should be mentally adjusted to reflect the new time period.  
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Once you have started a new report or opened an existing report, a box will pop up which is the Configure 

Report Organization.  In this box, you will select your organizations name from the drop-down box in the 

organization line.  If your organization is not listed in the drop-down click on the box that states Organization 

Not found In List for further instruction.  In region section you will have to select statewide.  Then click OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You will then see a report configuration box.  Click the Next tab in the bottom right corner. 
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A second report configuration box will appear once you have completed selecting your counties of service.  

Click Finish in the bottom right hand corner. 

 

                                            

The Save Report Configuration box will come up next to show you where your report is being stored on your 

computer.  You can change where you want it stored by clicking the change location button. 
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General Information Form 

 

The General Information Form is part of the Report Manager Software and collects information about your 

organization that not only identifies you but enables the submission and certification of your report as well as 

the successful transfer of your data to a data repository.   

 

 

When you open the report, you will receive a pop-up box that requests that you fill in the General Information 

Form.  You must fill in the General Information Form prior to submitting the report. 
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The General Information Form information section will be filled in for you.  You only need to fill in the 

Contact Person and Address sections. 
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Form ALP1 – Agency Form 

 

Form ALP1 - Agency Form collects agency location, contact information and other information.  

 

 
 

 

Agency and Contact Information Section 

All fields in this section, except for NPI number, are required fields.  You will not be able to submit the 

statistical report if this information is not filled in. 
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Form ALP2 – Resident Form 

 

Form ALP2 - Resident Form collects resident demographic information, including discharges and referrals.  

 

 

 
Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

Residents Section 

Enter information for Resident Census.  Enter the resident census as of December 31 of the report year 

(12/31/2019).  Resident Census means the actual number of individual residents receiving services. 

 

Enter the Unduplicated Resident Count in the next field.  This is the total number of discrete individual 

residents that your agency has served in the year, regardless of the number of admissions and discharges that 

resident may have had.   A resident is only counted once regardless of the number of cases they represent. 

 

To recap, if a resident is receiving care on 12/31/2019 they will be included in the resident census count. If 

they had two admissions during the year, they will count as two cases but as only one unduplicated resident.  

 

Length of Stay Section 

Length of Stay (LOS) information is entered in the next section. LOS is calculated for each episode of care or 

case. Length of stay should be calculated from the date the resident was initially admitted for an episode of 

care, regardless of the year of admission, to the date they were discharged.  For example, if a resident was 

admitted on 12/30/2018 and discharged on 1/10/2019 her LOS is 12 days.  Count the 2 days in 2018 and the 

10 days in 2019 to arrive at a 12 day LOS.  Residents that were discharged to a hospital or RHCF and 



Send questions to hcstatrpts@health.ny.gov   pg. 9 
 

readmitted to the agency within 30 days with the same illness or diagnosis should NOT be counted in the 

length of stay section. 

 

Validation Edit - The total number of discharges calculated from the LOS entries on row 20 of ALP2 must 

match the total number of discharges calculated from the “Discharged To” section on row 30 of ALP2. 

 

 

Referrals and Discharges Section 

The next section collects resident referral and discharge information. In the “Referred From” column enter the 

number of cases served by your agency that have been referred from each of the designated sources regardless 

of their start of service date. This means that if you are serving a case in 2019 that was referred to your agency 

in 2018, that case should be counted.  Residents that were discharged to a hospital or RHCF and readmitted to 

the agency within 30 days with the same illness or diagnosis should not be counted in the discharge section.  

 

In the “Discharged To” column enter the number of cases discharged during the reporting year to specific 

destinations.  
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ALP3 – Cost Form 

 

ALP3 – Cost Form - collects data on revenue and costs for providing services to residents.   

 

 
 

 

Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

One lines 1 and 2 enter the total number of days of care and total revenue for the report year.   

 

On line 3 the system will calculate the average revenue per day of care by dividing the revenue by the days of 

care.   

 

Enter total costs for the report year on line 4 and the amount of capital related costs on line 5. 

 

• Capital and Related costs are onetime costs for construction, major repairs to real estate owned by the 

agency, etc. 

 

On line 6 the system will calculate Operational Costs by subtracting the amount of capital costs from the total 

costs. 

 

On line 7 the system will calculate the average operational costs per days of care by dividing the operational 

costs by the total number of days of care. 

 

 

 

 

 

Enter the Administrative and General Costs of line 8 
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• Administrative and General costs are expenses for activities and materials that are used to administer 

your business. Examples are rent, utilities, and office supplies. 

 

On line 9 the system will calculate a percentage by dividing the administrative costs by the operating costs. 

 

On line 10 and 11 enter the costs to provide Home Health Aide and Personal Care Aide services. 

 

On line 12 the system will calculate total HHA and PCA Costs. 

 

On line 13 the system will apply the percentage from Line 9 to the total HHA and PCA costs on line 12.  
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ALP4 – Staff and Wages Form 

 

ALP4 – Staff and Wages Form - collects information by staff type for full time and hourly staff at two 

different dates during the reporting year and the total number of W2s issued, hours worked, wages, and fringe 

benefits.   

 

 
 

 

Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

Enter the number of full-time and hourly staff at your agency on April 1 and October 1. The current definition 

of a full-time staff is someone who works an average of 30 or more hours a week and 130 hours or more per 

month.  The form will calculate the average number of full time and part time staff in the first two lavender 

columns. 

 

Enter the total hours worked for the year.  The form will calculate the number of FTEs represented by these 

hours by dividing the number of hours by 2,080. 

 

Enter total wages paid, and total fringe benefits paid for each staff type.  The amount of wages plus fringe 

benefits will be calculated.   

 

Enter the number of W2s issued during the year for each staff type. 
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ALP9WFC – Workforce Form C 

 

ALP9WFC – Workforce Form C - collects employee benefit information for four types of employees, and 

non-wage supports for all staff.   

 

This form requires some Yes or No Responses.  To answer Yes or No, double click on the white field and the 

following box will pop up. 

 

 
 

Choose your yes or no response to the question, click OK, and it will populate in the field. 
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Employees that receive health insurance or retirement plan benefits through the union, if the agency pays into 

the benefit, should be counted as enrolled in employer-provided health insurance or employer-sponsored 

retirement plan.   

Short-term disability insurance may include the required coverage under New York State law or supplemental 

coverage that the agency offers. 
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ALP10 – Registration Form  

 

ALP10 – Registration Form - collects an attestation that indicates the ALP LHCSA is currently operational 

and serving residents.  If the ALP LHCSA has opened in the past year, you can report on the form that the 

ALP LHCSA is not yet operational and is currently not seeing residents.    

 

Some fields on this form are required fields.  You will not be able to submit the statistical report if this 

information is not filled in. 

 

The appropriate Governing Authority Agent must request that the ALP LHCSA be registered with the 

Department of Health for the upcoming calendar year.  
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Validating the Statistical Report 

 

You may, at any time, validate the sheet you are working on, or validate the entire report.  You must validate 

the report before submitting it. 

 

Go to the top tool bar and click on the drop down box next to the green arrow. 

 

 
 

 
 

 

You can validate a worksheet at any time.  You can also refresh the validation after it’s been done once by 

clicking the refresh circle in the details portion of the report.  Because there are so many worksheets, it may 

be easier to validate each worksheet once you’ve finished it.  The results of the validation are in a table in the 

details section of the worksheet.  The message that says “Rule Passed Validation” is only referring to the cell 

you are on – not the whole worksheet. 

 

 
 

 

IMPORTANT NOTE:  The details section is automatically set up to show all rules.  It’s only an error if there 

is a checkmark in the error box 

 

 
 

 

To see if you have any cells with errors – click on the filter in the details section and change it from “all rules” 

to “critical errors”. 
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Validations can be done for the worksheet you are on by checking the box that says “Current Worksheet” or it 

can be done for all worksheets by unchecking the box.   

You can fix an error and then re-run the validation by clicking on the refresh circle. 

 
 

 

If you have passed the validation edits you will have no error boxes checked and get a green message that 

says Rule Passed Validation for each cell you choose. 

 

Finalizing the Statistical Report 

 

If you have passed all the validation edits, and you are satisfied with all responses on all forms, click on the 

Finalize Report icon. 

 

 
 

 

Or click Action on the top tool bar and choose “Finalize Report” 

 

 
 

 

A message will come up asking if you are sure you want to save and finalize.  Click Yes. 

A second message will come up directing you to correct errors (if there are any) or letting you know that the 

report has been finalized. 

 

Select a location to save your Finalized Report. Make sure that you are aware of where it is being saved 

(i.e. desktop) as you will need to find the file when you upload it onto the Healthcare Financial Data 

Gateway.  You may wish to make a new folder on your desktop and save it there. 

You will save a PDF of the report, as well as a .pnp file of the report. 

 

The name of the report will be: 

Agency Name_(Agency License Number)_Statewide_2019_A00.pnp 

 

The file you will want to upload will end in “.pnp” 

 

Your report is now ready to be submitted to the Healthcare Financial Data Gateway. 
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Submitting the Finalized ALP LHCSA Statistical Report to the Healthcare Financial Data Gateway 

 

1. Login to the HCS.  

2. Click on Healthcare Financial Data Gateway in My Applications. This will take you to the 

Healthcare Financial Data Gateway main page.  
 

 

 
 

 
3. Click the Submissions tab – the Submissions page will display 

 

 

 
 

4. Select ALP LHCSA as the Submission Type and your organization from the Organization list and 

then click the Search button. The Submission page will be expanded. 
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5. Click the Browse button to display a dialog box that allows you to locate your finalized ALP LHCSA 

Statistical Report. It will have a .pnp file extension.  

6. Once you have selected the file to submit, click the Submit button. 

7. The Submission History section of the Submission page will be updated to reflect the status of the 

submission. 

8. A confirming email message will be sent to the email address listed in the New Submission section of the 

Submission page. 
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Attachment A – Report Tool Bar items 
 

Worksheets 

Worksheets 

 

The Worksheets are listed in the Worksheet Panel which is located on the left side of the application 

window. Worksheets are listed in alphanumeric order by Worksheet name. Click on a Worksheet to view 

that Worksheet in the Matrix Panel. Click on the small arrow key in the top right of the Worksheet Panel to 

collapse or expand the panel. Use the "Windows" menu item to organize your Worksheets in the Matrix 

Panel. 

Title Bar 

Title Bar 

 

The Title Bar is located at the very top of the window and will display the name, version and software build 

number, followed by the name of the active matrix table if a table is currently open. 
 

Menu Bar 

UDCS Menu bar 

 

The following Help Topics will guide you through the menu bar functionality. 

 

File 

The File Menu. 

 
Report Manager: Select Report Manager to return to the Report Manager.  
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New: This command will start a new Report 

 

Open: This command will enable you to open an existing Report 
 

Save: This will save the Report you are working on. 

 

Save Copy To: The Save Copy window will open and enable you to save a copy of your Report to a location 

that you choose. 

Your working report location will remain in the default location: C:\ProgramData\UDCS\report 

 

Print: Two options will be displayed that will enable you to save your Report as a Microsoft Excel 

document or a PDF document. 

For either option, the Select Worksheets window will open. Check the worksheets you wish to export or 

check Select All to check all the worksheets. 

You will be prompted to save the export file to a location you choose. You can then open the file from this 

saved location and print. 

 

Close Report: Closes the Report. You will be prompted to save your data first. 

 

Exit Program: Closes the UDCS software and the Report Manager. You will be prompted to save your data 

first. 
 

Edit 

The Edit Menu 

 
Cut, Copy, Paste, Undo 

 

 

These features will enable you to copy data from one part of your report to another, or from Microsoft Excel 

to your Report with some limitations: 

1) You may copy numeric data to numeric or non-numeric type cells. You may not copy non-numeric data to 

numeric type cells. 

 

2) You may not paste data into read only cells such as targets of formulas. 

 

3) You may select a range of cells to copy. However, when you paste the cells, the range size must match. If 

the range size does not match, you will not be allowed to copy the data. 

For example, if you copy a 5 cell by 5 cell range and try to paste in a 3 cell by 3 cell area, or the area has 

read only cells, you will be alerted to adjust your range. 
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View 

The View Menu 
 

 
 

Report Type: You can choose to Select All Worksheets to display all the worksheets in the Report in the 

Worksheet display panel. 

For Reports that have multiple Report Types, you may choose to select only the worksheets from the 

selected Report Type. 

 

Worksheet Panel (Expand-Collapse): Expands or collapses the worksheets panel. It may be convenient to 

collapse the worksheet panel 

when you are working on a large worksheet and could use extra space to see more of the worksheet. 

 

With the worksheets collapsed you may also click on the arrow icon where the worksheets are collapsed to 

expand the worksheets. 

Previous Worksheet and Next Worksheet: Use these commands to navigate through the worksheets. 

 

Detail Pane (Expand-Collapse): Use this command to expand or collapse the Details panel. This works 

similarly to 

expand-collapse worksheets. 

 

The following menu items will each open a window that will enable you to Export the data as a text file. 

Calculations: A window will open that lists all of the mathematical expressions in the Report. 

 

Text Transfers: Lists all the Text Transfers in the Report. 

Text Transfers consist of a value and a target. Once the value is entered, the target will 

automatically get populated with the same value. 

 

Validation Rules: Lists all the Validation Rules in the Report. 

Validation Rules are conditions that must be met for the report to be completed satisfactorily. 
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Submission Output: This is the XML output of the Report. It lists Report configuration information 

as well as class code/line numbers and the values that were entered for them. 

 

Configure 

The Configure Menu 

 
 

Control Data: Contains information that is required for the Report to be completed correctly and allowed to 

be submitted. 

All required Control Data fields must be complete. Required fields will have a red exclamation point next to 

them. 

When you open the Report, you will be alerted if the Control Data information is not completely filled out. 

 

Report Settings / Report Types: These menu items are merely instructions to remind you what to do f you 

have created your report using the wrong configuration information, such as the wrong Report Type or wrong 

Region. Click on the File menu to Start a New Report. Select the correct settings and then transfer your data 

from the incorrect Report to the new Report. 

Action 

The Action Menu 
 

 

Validation Method: Current Worksheet or Entire Report. 

In order to Finalize the Report for Submission you must run it through the validation process. You can 

validate to check only the current Worksheet, or you can run Validation for the entire Report. You must 

Validate the entire Report in order to pass Validation and have a Finalized Report that is ready to submit. 

 

Start Validating/Stop Validating: Once you have selected to validate the current Worksheet or the entire 

Report you can 

select the Start Validating item. For larger Reports, you may choose to Stop Validating at any time. 
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Notepad 

The Notepad Menu 

 

This is a scratch pad to keep notes and provide additional information while you complete your report. Click 

the File menu and then Save to save Notes to your Report. 

Use the File and Edit menu as you would a typical text editor. 

Windows 

The Windows Menu 

 

Use the Windows commands to arrange the Worksheets to your satisfaction. 

Select the Worksheets command to see a list of opened Worksheets. You may select an open Worksheet to 

bring it to the front of the Report. 
 

 

Search 

The Search Menu 

 

Enter what you would like to search for in the Search box and click the Search button. 

All results that match your Search criteria will be listed below. You may choose to Search 

the Current Worksheet or All Worksheets by toggling the radio buttons at the bottom of the window. 

Help 

The Help Menu 

 

View Documentation will open the Help File that you are currently reading. 
 

 

Click About to open the following window. This information contains details about the Report you have open 

as well as the versions of the software and files being used. 
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Icon Menu 

 
Icon Menu 
 
 
 
 

        Open the Control Data Form. 
 
 
 
 

         Start a New Report. 
 
 
 

       Open an Existing Report. 
 
 
 
 

        Save the Report. 
 
 
 
 

        Close the Report. 
 
 
 
 

        Validate the Current Worksheet or the Entire Report. 
 
 
 
 

        Stop the Validation process. 
 
 
 
 

        Finalize the Report. 
 
 
 
 

        Open Notepad. 
 
 
 
 

        Open the Previous Worksheet. 
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         Open the Next Worksheet. 
 
 
 
 

         Export the Worksheet as a PDF document. 
 
 
 
 
 

         Export the Worksheet as an Excel file. 
 

          Open the Search Window. 
 

 



2019 Assisted Living Program (ALP) Licensed Home Care Services Agency (LHCSA) 

Statistical Report Frequently Asked Questions 

 

Q. Where can I find instructions and documentation for the 2019 ALP LHCSA Statistical Report? 

A. Sign on to the Health Commerce System (HCS) 

     Click on: 

• My Content on the top purple tool bar 

• Documents by Group 

• View all Document Groups 

• Long Term Care 

• Training 

• Home Care 

• LHCSA Statistical Report 

 

Q:  Our Agency was not open in 2019 – do we need to submit a report? 

 

A:  If your agency was newly opened in 2020, you may register using the LHCSA Registration 

Short Form HERDS survey. You will need to send a note to HCStatRpts@health.ny.gov 

requesting access to the survey. Once this request is received, DHCBS staff will work with you 

to register your LHCSA.  

 

Q:  Our Agency was open in 2019, but did not serve patients – do we need to submit a report? 

 

mailto:HCStatRpts@health.ny.gov


A:  You must complete and submit the 2019 ALP LHCSA Statistical Report to register your 

agency with the Department of Health.  You must fill out the contact information on form ALP1 

Agency Information Form and fill out form ALP1 Registration Form entirely.  If your agency has 

staff, you must complete and submit forms regarding Staffing and Wages, Costs and Workforce. 

 

Q:  Our Agency is an ALP LHCSA that exclusively serves patients of an Assisted Living 

Program.  What needs to be submitted? 

 

A:  LHCSAs that EXCLUSIVELY serve patients in an Assisted Living Program are only required 

to submit the 2019 ALP LHCSA Statistical Report Form. 

 

If your agency is a LHCSA that serves ALP residents and also serves patients in the 

community, you must complete and submit all forms on the 2019 LHCSA Statistical Report in 

regards to your patients in the community AND the 2019 ALP LHCSA Statistical Report in 

regards to the patients in the Assisted Living Program (ALP). 

 

Q:  I do not have access to the 2019 ALP LHCSA Statistical Report on the Healthcare Financial 

Data Gateway.  What can I do? 

 

A:  People who were able to access the Healthcare Financial Data Gateway last year to 

download the software and the report continue to have access this year.   If you are in the 

Administrator role and are unable to access the Gateway, please send an email to 

HCStatRpts@health.ny.gov.  If you are not assigned the Administrator role on the Health 

Commerce System – you should discuss with your administrator what they would like to do 

regarding giving you access to the report. 
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Q. Do I have to be assigned the Administrator role to enter data into the 2019 ALP LHCSA 

Statistical Report? 

 

A. No. Once the software is installed on a computer and the Report format is loaded, anyone 

with access to that computer can enter data. However, only someone assigned the 

Administrator role can submit the report.  

 

Q. My agency has multiple people assigned the Administrator role who are also registered with 

the Healthcare Financial Data Gateway so that they can download the software and report and 

can submit the final report. Should they all download a copy of the application and report? 

 

A. The answer is it depends. They can each download and install the software on their 

computer, but care must be taken that all of them only enter data into a single, shared copy of 

report. If they enter data into private copies of the report, the private copies cannot be merged. If 

they submit private copies of the report, only the data from the last submitted copy will be 

available. See the next question.   

 

Q. How can multiple people enter data into an ALP LHCSA Statistical Report? 

 

A. You may want to have different people fill out different parts of the ALP LHCSA Statistical 

Report. For example, you may want someone from your fiscal unit to fill out the cost section, 

someone from human resources to complete the staffing and workforce sections and someone 

else enter the patient and service data.  This can be done in different ways, but care must be 

exercised so that only one person is entering data into a report at a time. If more than one 



person enters data into a report at the same time, only the changes made by the last person to 

save their copy of the report will be retained. 

 

The simplest way to have multiple people work on the report is to install the application on a 

single computer and have people use that computer to enter data into a report stored on the 

computer. This enforces the requirement that only one person enter data at a time. 

 

Another way to have multiple people input data is to install the application on the computers of 

everyone who will be entering data. The application and report can be downloaded once, stored 

on a file server or flash drive, and then installed from the server or flash drive onto the 

computers of all the people who will be entering data.  

 

One person should then create and save the initial instance of the report for a license. The 

default location for this file (which has an extension of .pnp) will be in the My Documents\UDCS 

folder of the person who created the report. A copy of this file can then be placed on a file 

server where it can be accessed by those who have had the application installed on their 

computer.  

 

Only one person should enter data into the report at a time. If more than one person enters 

data into a report at the same time, only the changes made by the last person to save 

their data will be retained. Also, everyone must enter data into this one report. Data entered 

into other copies of this report cannot be merged into this one report and will have to be re-

entered. 

 

Alternatively, the initial instance of an ALP LHCSA Statistical Report can be stored on a single 

flash drive which can be given, in succession, to each person who will be entering data. These 



people must have the ALP LHCSA Statistical Report application installed on their computers. All 

people entering data must save it to the same flash drive; there is no way to merge data entered 

into multiple instances of an ALP LHCSA Statistical Report into a single copy. 

 

Q:  I’ve downloaded the Report Manager software, but I get an error message when I try to 

install it on to my computer.  What can I do? 

 

A:  You may not have the privileges needed to install software on to your computer.  You may 

need to contact your IT Department and have them install the software on to your computer.  

Please note that the Report Manager software requires Windows 7 or later operating system.   

 

Q:  I’ve tried to download the Report Manager software on my Mac computer, and it does not 

work.  What can I do? 

 

A:  Report Manager software requires Windows 7 or later operating system.  It will not work on a 

Mac.  You must use a computer that has Windows to submit your 2019 ALP LHCSA Statistical 

Report. 

 

Q. I have downloaded and installed the software, but when I download the Report and try to 

open the downloaded file, I get a prompt for a password or an error message that says the file 

may be damaged. How can I download the Report? 

 

A. The file containing the ALP LHCSA Statistical Report matrix is a .zip file that contains an 

encrypted file. Depending on how your browser is configured, it may attempt to open the .zip file 

for you. You do not need to open this file and extract the contents; you should save it where you 

can locate it and load it into the Report Manager. 



 

Q: I have completed the report and finalized and saved it.  When I go to upload the report on the 

Healthcare Financial Data Gateway, I get the error message that says I cannot upload a PDF 

file.  What do I need to do? 

 

A:  When you finalize the report and are asked to save it, the software will save both a PDF 

version of the file and a PNP version of the file.  You must upload the PNP version. 

 

FAQs about the Forms: 

 

ALP2 

 

Q: What is meant by resident census? 

 

A: Resident census is the number of residents being served at a particular point in time.   

 

Q: What is meant by unduplicated resident count? 

 

A: The unduplicated resident count is the number of discrete individuals provided with 

home care services.  A resident is counted only once regardless of the number of cases that 

they represent. 

 

ALP3 – Cost From 

 

Q: If certain costs fall into two categories, should they be listed twice? 

 



A: No.  Do not double count costs.  Choose one of the cost categories and enter the cost 

only once. 

 

Q:        Do costs related to the delivery of services include the wages paid to the                                                                                               

employee giving the services? 

 

A: Yes. Include Wages in the costs on ALP3 – Cost Form. 

 

Q: What is meant by Administrative and General Costs? 

 

A: Administrative and General Costs are expenditures related to the day-to-day operations 

of a business.  These costs pertain to the operation of the business, rather than the cost for 

services to patients.  Examples include rent, utilities, and office supplies. 

 

Q: What is meant by Capital and Related costs? 

 

A: Capital and related costs are fixed, one-time costs incurred for the purchase of land, 

buildings, or construction.  Building improvement costs that add to the value of the property are 

included in capital costs.  Maintenance of buildings and property are not included in capital 

costs. 

 

ALP 4 – Staff and Wages Form 

 

Q: What is meant by full time employee and hourly employee? 

 



A:  The IRS defines a full-time employee as an employee who works on average at least 30 

hours per week, or 130 hours per month.  Employees that work less than this should be 

considered hourly. 

 

Q: What is included under fringe benefits? 

 

A: Fringe benefits are employment benefits granted by an employer that have monetary 

value but do not affect basic wage rates.  Fringe benefits may include health insurance, vision 

and/or dental insurance, paid holidays, pension, or items such as uniforms, or a company car. 

 

Q:   We pay HHAs/PCAs bereavement, jury duty, overtime, Paid Time Off (PTO), holidays, 

travel time, annual medical exam time, in service/special training time etc.  Are these 

considered fringe benefits? 

 

A:  Yes.  These items can be included as fringe benefits on forms ALP3 Cost Form and the 

ALP4 Staff and Wages form. 
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